
 

 

 
LEGAL NOTICE  

for the www.converteam.com  website 
 

 
The aim of this legal notice is to define the terms under which the Converteam Group company 
(hereinafter “Converteam”) provides users with information relating to its activity on the 
www.converteam.com site. 
 
They apply to all use of the www.converteam.com site on whatsoever media (computer, mobile phone, 
television screen, etc.).  
 
User means any person accessing the www.converteam.com site and navigating on the pages of the 
said site.  
All Users are subject to these legal details and they therefore declare that they have read them.  
 
Converteam may amend the Notice at any time, without prior notice by displaying the said changes as 
soon as possible on the www.converteam.com internet site.  
 
Consequently the User must refer regularly to the latest version, which is permanently available on this 
site.  
 
In view of the international scope of Converteam, whose offer is also intended for professionals, the 
content of the www.converteam.com website is written in English. However, in order to enable all 
Users to read the Notice usefully and to be properly informed of their rights and commitments resulting 
from use of the site, the Notice is also available in French.   
 
 

ARTICLE 1. IDENTIFICATION 
 
Company publishing the “converteam.com” site: 
Converteam Group, a simplified joint stock company with a registered capital of €14,200,000 
30 avenue Carnot, 91345 Massy Cedex, France 
Registered with the Evry Trade & Companies register under n°477 832 638 
Telephone: +33 (0)1 64 5 83 00 
Fax: +33 (0)1 64 53 83 04 
Email: external.communications@converteam.com 
 
 
Director of publication: Pierre Bastid – President & CEO 
 
 
Hosting provider: 
Company: Ecritel 
Registered capital: €750,000 
Address of head office: 3 rue de Pondichery – 75015 Paris, France 
Registry of: Paris 
Trade & Companies register: 332 484 021 
 



 

 

 
ARTICLE 2. INTELLECTUAL PROPERTY 

 
The general structure of this site and its contents (texts, animated or non-animated graphics, articles, 
sounds, logos, brands, etc.) are protected by current legislation in France in terms of intellectual 
property, and particularly by copyright, neighboring rights, brand rights, image rights and by current 
international legislation in force.  
Converteam holds the intellectual property rights required in order to put on line the 
www.converteam.com internet site and represent its content (graphic guidelines, general structure of 
the site, etc.). 
All rights of reproduction are reserved, including but without this list being limitative, for photos, texts, 
downloadable documents, iconographic representations, logos, etc.  
Any representation, reproduction, modification or distortion, either total or partial, of the internet site or 
its content, by any process whatsoever and on any medium whatsoever is forbidden without express 
prior authorization from Converteam, and may result in legal action. 
 
 

ARTICLE 3. HYPERLINKS 
 
This site may contain links with third party sites. Converteam formally declines any responsibility with 
regard to the content of the sites towards which hyperlinks are made. These links are provided with 
the sole purpose of ease of use and the inclusion of these links does not in any way imply any kind of 
control over the elements contained in the sites to which the links give access nor any kind of 
endorsement nor any kind of guarantee over these elements. Access to these sites happens under the 
sole responsibility of the User. 
 
No hyperlink towards the Converteam website may be set up by a third party without prior, specific, 
written authorization from Converteam. 
 
 

ARTICLE 4. PROTECTION OF PERSONAL DATA  
 
Converteam undertakes to ensure that the collection and processing of data of a personal data made 
from the site and for which Converteam is responsible, takes place in accordance with the law n°78/17 
of 6th January 1978 relating to computerized data, files and personal freedoms, known as the law on 
“Computerized Data and Personal Freedom”, lately modified by law n° 2006-64 of 23rd January 2006.  
 
By data of a personal nature Converteam means all information relating to an identified individual or 
someone who is identifiable by one or several elements specific to him and which are provided on the 
Converteam site, particularly for contact purposes.  
 
The information thus supplied on the site permits processing of User demands.  
 
This information is also intended to perfect the marketing of Converteam’S products and services to 
Users and to facilitate and maintain commercial relations between Converteam and the Users and, 
where applicable, to perform the obligations pertaining to the services from which the User wishes to 
benefit.   
 
For these purposes, data of a personal nature collected on the Converteam site may be transmitted to 
Converteam staff and to any Converteam subcontractor, as well as to its partners.   
 
Personal information collected within the context of the service will be retained in accordance with the 
rules set forth in the law on Computerized Data and Personal Freedom, for a period justified by the 
purpose of their processing.   
 
In accordance with the provisions of the law on Computerized Data and Personal Freedom, a User of 
the www.converteam.com internet site has the possibility of opposing processing by Converteam of 
the personal data concerning him, as well as the right to oppose, at no charge, having his personal 



 

 

data used for prospecting purposes, particularly of a commercial nature, by Converteam or, where 
applicable, by its partners to whom the personal data collected will be passed.  
 
Opposition to the processing of data of a personal nature may have the consequence of preventing 
Converteam from carrying out the service requested, and it may not be blamed for this.   
 
The User enjoys a right of access, of communication, modification, rectification and removal of the 
information concerning him and collected during his visits to the Converteam site. 
 
The user also has the right to question Converteam with a view to obtaining confirmation that his 
personal data is or is not the object of any kind of processing, as well as any information relating to the 
purposes of the processing and/or the categories of recipients to whom the said information is being 
passed. A copy of the personal data held on the User may be sent to him on request and in return for 
payment of the cost of reproducing the latter.   
 
These rights may be exercised by e-mail sent to the following address: 
external.communications@converteam.com. 
 
However, Converteam has the possibility of opposing any demands that are clearly unfair, specifically 
in terms of their number or their repetitive or systematic nature.   
 
A declaration has been made to the French control authority (the  National Commission on 
Computerized Data and Personal Freedom, known as the "CNIL") on xxx under n° xxx (pending), as 
required by the provisions of the law of 6th January 1978 relating to computerized data, files and 
personal freedoms, as modified.  
 
The group with responsibility for processing is Converteam Group. 
 
Although data collected may be shared with agents or companies under contract with Converteam or 
its affiliated companies for the purposes of service provision on behalf of Converteam, Converteam will 
abstain in all circumstances from selling, renting or commercializing in any way whatsoever to a third 
party, the User’s personal data without first obtaining his prior authorization.  
 
Converteam informs Users that other websites which they are liable to access through its own site, 
specifically by the hyperlinks, may collect information that can be identifiable individually and which 
concerns them. These sites do however have their own legal notice. This Notice cannot apply to their 
content and Converteam may not be held responsible for the consequences of navigation by Users on 
these pages.  
 
 

ARTICLE 5. COOKIES 
 
Converteam may be caused to use cookies on the www.converteam.com internet site in order to 
facilitate access to the pages on its internet site.  
 
These cookies are used to record information relating to navigation of the User’s computer on the 
www.converteam.com internet site (pages consulted, date and time of the consultation, etc.) which 
may be read by Converteam during later visits, thus accelerating page downloading time. These 
cookies may include information supplied by Users. On the other hand they do not permit identification 
of the User.  
 
This cookie or these cookies will be kept in the User’s computer for xxx months. 
 
The User may oppose the recording of "cookies" by configuring his navigator as follows: 
 
For Mozilla firefox : 

1. Choose the “tools” menu and then "Options" 
2. Click on the "private life” icon 
3. Identify the "cookie" menu and select the options required by the User. 



 

 

 
For Microsoft Internet Explorer 6.0 :  

1. Choose the "Tools" menu and then "Internet options"   
2. Click on the "Confidentiality" tab 
3. Select the level required using the cursor.   

 
 
For Microsoft Internet Explorer 5    

1. Choose the "Tools" menu and then "Internet Options" 
2. Click on the "Security" tab 
3. Select "Internet" and then "CustomLevel" 
4. Identify the "cookies" menu and choose the option required by the User.  

 
For Netscape 6.X et 7. X : 

1. Choose the "Edition">"Preferences" menu 
2. Confidentiality and Security  
3. Cookies. 

 
For Opera 6.0 and over : 

1. Choose the "File" menu >"Preferences"  
2. Private Life. 

 
 

ARTICLE 6. LIABILITY 
 
The site’s main aim is to present the activity of the company Converteam. To date it is not possible to 
order products or services through this site.   
 
- Accessibility:  
Converteam allows access to its on-line portal 24 hours a day and 7 days a week. However 
Converteam has the right, at its sole discretion, to suspend, interrupt or cancel access to all or some of 
the portal in the following cases, the list of which is not limitative: force majeure, computer problems, 
difficulties in terms of the structure of the telecommunications network or difficulties of a technical 
nature, or for reasons involving the updating of information contained on the site or maintenance.  
 
Converteam does not guarantee, moreover, uninterrupted access to this site or the security of the site 
or the absence of any virus or other undesirable  elements (including in elements on the site and in 
information incorporated into it) or that the information published on the site will be at all times 
exhaustive, exact and up-to-date.   
 
- Content: 
Converteam uses its best efforts to present on its website exact information relating to its products.   
 
Any information provided on this site is provided "as is", without any guarantee of any kind either 
specific or implicit, whether this concerns, and without this being limitative, any guarantee of loyal 
trading quality suitability for a specific requirement or non-counterfeit of third party rights.   
 
Also, Converteam works at international level and consequently the site may permit access to 
information or make reference to Converteam products, processes, programs and services that are 
not available in the User’s country. This does not mean that Converteam plans to offer such products, 
processes, programs and services in the country in question.  
 
- Information exchanged:  
Converteam does not guarantee the User any secrecy in terms of correspondence by electronic mail 
or any other communications using the internet network and which may be captured by a third party, 
due to the way in which data circulates on the network.  
Each user shall take all the appropriate measures to protect his own data and/or software from 
contamination by any viruses that may be circulating on internet.  
 



 

 

Also, Converteam may not be held responsible for the direct or indirect consequences liable to result 
from typing errors that may be committed by the User or for any inexact or incomplete information 
transmitted by it via the site.   
 

 
ARTICLE 7. APPLICABLE LAW 

 
In accordance with article 17 of the Law for Confidence in the Digital Economy (Law n°2004-575 dated 
21st June 2004), French law is applicable to this website.  
 
Any argument or dispute linked to usage of this website will be exclusively settled by the French courts 
with jurisdiction.  
 
Application of the rules on conflicts of law that may restrict full application of French law is hereby 
excluded. Consequently, French law applies to everyone navigating on this site and who use all or 
some of its functionalities.  
 
******************** 
© - Converteam – 2008. 
 
 



 

 

 
 

MENTIONS LEGALES 
du site « www.converteam.com » 

 
 
Les présentes Mentions Légales ont pour objet de définir les modalités dans lesquelles la société 
Converteam Group (ci-après « Converteam ») met à la disposition des Utilisateurs des informations 
relatives notamment à son activité sur le site www.converteam.com.  
 
Elles s’appliquent à toute utilisation du site www.converteam.com et cela, quel que soit son support de 
diffusion (ordinateur, téléphone portable, écran de télévision, etc…). 
 
On entend par Utilisateur toute personne accédant au site www.converteam.com et naviguant sur les 
pages de celui ci. 
Tout Utilisateur est soumis aux présentes Mentions. Il déclare et reconnaît, en conséquence, en avoir 
pris connaissance.  
 
Converteam peut modifier les Mentions à tout moment, et sans avertissement, en faisant apparaître 
dans les meilleurs délais lesdites modifications sur le site Internet : www.converteam.com.  
 
Il appartient en conséquence à l'Utilisateur de se référer régulièrement à la dernière version des 
Mentions, disponible en permanence sur ce site. 
 
Etant donné le rayonnement international de Converteam, dont l'offre est, en outre, destinée aux 
professionnels, le contenu du site www.converteam.com est rédigé en langue anglaise. Toutefois, afin 
de permettre à tout Utilisateur de prendre utilement connaissance des Mentions et d'être 
régulièrement informé de ses droits et engagements résultant de l'utilisation du site, les Mentions sont 
rédigées en français.  
 
 

ARTICLE 1. IDENTIFICATION 
 
Société éditrice du site « converteam.com » : 
Converteam Group, société par actions simplifiée au capital de 14.200.000 € 
30 avenue Carnot, 91300 Massy Cedex, France 
Immatriculée au RCS d'Evry sous le n°477 832 638 
Téléphone : +33 (0)1 64 53 83 00 
Télécopie : +33 (0)1 64 53 83 04 
Email : external.communications@converteam.com 
 
 
Directeur de la publication : Pierre Bastid – Président et CEO 
 
 
Hébergeur du site:  
Société : Ecritel 
Capital social : 750 000 € 
Adresse du siège social : 3 rue de Pondichéry – 75015 Paris, France 
Greffe de : Paris 
RCS : 332 484 021 
 



 

 

 
ARTICLE 2. PROPRIETE INTELLECTUELLE 

 
La structure générale de ce site et l’ensemble des éléments qu’il contient (les textes, les images 
animées ou fixes, les articles, les sons, les logos, les marques…) sont protégés par la législation en 
vigueur en France en matière de propriété intellectuelle, et notamment par le droit d'auteur, les droits 
voisins, le droit des marques, le droit à l'image, et par la législation internationale en vigueur.   
Converteam est titulaire des droits de propriété intellectuelle nécessaires pour mettre en ligne le site 
Internet www.converteam.com et représenter son contenu (charte graphique, structure générale du 
site,  etc.). 
Tous les droits de reproduction sont réservés, y compris, sans que cette liste ne soit limitative, pour 
les photos, les textes, les documents téléchargeables, les représentations iconographiques, les 
logos… 
Toute représentation, reproduction, modification, dénaturation, totale ou partielle du site Internet ou de 
son contenu, par quelque procédé que ce soit et sur quelque support que ce soit, sans l’autorisation 
expresse et préalable de Converteam, est interdite et peut être passible de poursuites judiciaires.  
 
 

ARTICLE 3. LIENS HYPERTEXTES 
 
Ce site peut contenir des liens avec des sites tiers. Converteam décline formellement toute 
responsabilité quant aux contenus des sites vers lesquels des liens hypertextes sont mis en place. 
Ces liens sont fournis aux seules fins de commodité et l'inclusion de ces liens n'implique en aucune 
façon un contrôle des éléments des sites auxquels les liens donnent accès ni un quelconque aval à, ni 
une quelconque garantie sur, ces éléments. L'accès à ces sites est de la seule responsabilité de 
l'Utilisateur. 
 
Aucun lien hypertexte vers le site web de Converteam ne saurait être mis en œuvre par une tierce 
partie sans l’autorisation expresse, préalable et écrite de Converteam. 
 
 

ARTICLE 4. PROTECTION DES DONNEES PERSONNELLES 
 
Converteam s'engage à ce que la collecte et le traitement de données à caractère personnel, effectué 
à partir du site et dont Converteam est responsable, soient effectués conformément à la loi n°78/17 du  
6 janvier 1978 relative à l'informatique, aux fichiers et aux libertés dite loi "Informatique et Libertés" 
dernièrement modifiée par la loi n° 2006-64 du 23 j anvier 2006.  
 
Par données à caractère personnel, Converteam entend toutes les informations relatives à une 
personne physique identifiée ou identifiable par un ou plusieurs éléments qui lui sont propres et qui 
seraient fournies sur le site Converteam notamment à des fins de contact. 
 
Les informations ainsi fournies sur le site permettent le traitement des demandes de l'Utilisateur. 
 
Elles sont, en outre, destinées à parfaire le marketing des produits et services de Converteam auprès 
des Utilisateurs et à faciliter et entretenir les relations commerciales entre Converteam et les 
Utilisateurs et, le cas échéant, à exécuter les obligations afférentes aux prestations dont l'Utilisateur 
souhaite bénéficier.  
 
A ces fins, les données à caractère personnel collectées sur le site de Converteam peuvent être 
transmises au personnel de Converteam ainsi qu'aux éventuels sous traitants de Converteam, mais 
également à ses partenaires.  
 
Les informations personnelles recueillies dans le cadre du service sont conservées conformément aux 
règles prescrites par la loi "Informatique et Libertés" et pendant une durée justifiée par la finalité de 
leur traitement.  
 
Conformément aux dispositions de la loi Informatiques et Libertés, l’Utilisateur du site internet 
www.converteam.com dispose de la possibilité de s’opposer au traitement par Converteam des 



 

 

données personnelles le concernant, ainsi que du droit de s'opposer, sans frais, à ce que ses 
données personnelles soient utilisées à des fins de prospection, notamment commerciale, par 
Converteam ou, le cas échéant, par ses partenaires auxquels seraient transmises les données 
personnelles collectées. 
 
L'opposition au traitement de données à caractère personnel peut avoir pour conséquence 
d'empêcher Converteam d'assurer la prestation demandée, ce qui ne saurait lui être reproché.  
 
L'Utilisateur bénéficie d'un droit d'accès, de communication, de modification, de rectification et de 
suppression des informations le concernant et collectées lors de ses visites sur le site de Converteam.  
 
L'utilisateur dispose également du droit d'interroger Converteam en vue d'obtenir la confirmation que 
ses données personnelles font ou ne font pas l'objet d'un traitement, ainsi que toute information 
relative aux finalités du traitement et/ou aux catégories de destinataires auxquelles celles-ci sont 
communiquées. Une copie des données personnelles détenues sur l'Utilisateur peut lui être adressée 
sur demande et contre remboursement des coûts de reproduction de celles-ci.  
 
Ces droits peuvent être exercés par courrier électronique à l'adresse suivante: 
external.communications@converteam.com. 
 
Toutefois Converteam a la possibilité de s'opposer aux demandes manifestement abusives, 
notamment par leur nombre, leur caractère répétitif ou systématique.  
 
Une déclaration a été faite auprès de l’autorité de contrôle française (la  Commission Nationale 
Informatique et Libertés, dite "CNIL") le xxx sous le n° xxx (en cours), conformément avec les 
dispositions de la loi du 6 janvier 1978 relative à l’informatique, aux fichiers et aux libertés modifiée. 
 
Le responsable des traitements est Converteam Group. 
 
Si les données collectées peuvent être partagées avec les agents ou entreprises sous contrat avec 
Converteam ou ses sociétés affiliées aux fins de la prestation de services pour le compte de 
Converteam, Converteam s’abstiendra en tout état de cause de vendre, louer ou commercialiser sous 
une forme quelconque auprès d’une tierce partie les données personnelles de l’Utilisateur sans avoir 
obtenu son autorisation préalable.  
 
Converteam informe les Utilisateurs que les autres sites Web auxquels ils sont susceptibles d’accéder 
au travers de son propre site, notamment par les liens hypertextes, peuvent collecter des informations 
identifiables à titre individuel les concernant. Ces sites ont toutefois leurs propres mentions légales. 
Les Mentions ne sauraient s'appliquer à leur contenu et Converteam ne saurait être tenu pour 
responsable des conséquences de la navigation par les Utilisateurs sur ces pages. 
 
 

ARTICLE 5. COOKIES 
 
Converteam peut être amené à utiliser des cookies sur le site Internet www.converteam.com afin de 
faciliter l'accès aux pages de son site Internet. 
 
Ces cookies permettent d’enregistrer  des informations relatives à la navigation de l’ordinateur de 
l’Utilisateur sur le site Internet www.converteam.com (les pages consultées, la date et l'heure de la 
consultation, etc.) qui pourront être lues par Converteam lors de visites ultérieures, accélérant ainsi le 
temps de téléchargement des pages. Ces cookies pourront inclure des informations fournies par les 
Utilisateurs. En revanche, ils ne permettent pas d’identifier l’Utilisateur. 
 
La durée de conservation de ce ou ces cookies dans l’ordinateur de l’Utilisateur sera de xxx mois. 
 
L’Utilisateur peut s’opposer à l'enregistrement de "cookies" en configurant son navigateur de la 
manière suivante : 
 
Pour Mozilla firefox  : 



 

 

1. Choisir le menu "outil " puis "Options" ; 
2. Cliquer sur l'icône "vie privée" ; 
3. Repérer le menu "cookie" et sélectionner les options qui conviennent à l’Utilisateur. 

 
Pour Microsoft Internet Explorer 6.0  :  

1. choisir le menu "Outils" (ou "Tools"), puis "Options Internet" (ou "Internet Options") ;   
2. cliquer sur l'onglet "Confidentialité" (ou "Confidentiality") ;  
3. sélectionner le niveau souhaité à l'aide du curseur.  

 
 
Pour Microsoft Internet Explorer 5  :  

1. choisir le menu "Outils" (ou "Tools"), puis "Options Internet" (ou "Internet Options") ;  
2. cliquer sur l'onglet "Sécurité" (ou "Security") ; 
3. sélectionner "Internet" puis "Personnaliser le niveau" (ou "CustomLevel") ; 
4. repérer la rubrique "cookies" et choisir l'option qui convient à l’Utilisateur. 

 
Pour Netscape 6.X et 7. X  : 

1. choisir le menu "Edition">"Préférences" ; 
2. Confidentialité et Sécurité ; 
3. Cookies. 

 
Pour Opéra 6.0 et au-delà  : 

1. choisir le menu "Fichier">"Préférences" ; 
2. Vie Privée. 

 
 

ARTICLE 6. RESPONSABILITE 
 
Le site a essentiellement pour objet de présenter l'activité de la société Converteam. Il n'est pas, à ce 
jour, possible de commander des produits ou des prestations par l'intermédiaire de ce site.  
 
- Accessibilité :  
Converteam permet un accès à son portail en ligne 24 heures sur 24 et 7 jours sur 7. Cependant, 
Converteam est en droit, à sa seule discrétion, de suspendre, d'interrompre ou d'annuler l'accès à tout 
ou partie du portail dans les cas suivants mais dont la liste n'est pas limitative : force majeure, 
problèmes informatiques, difficultés en rapport avec la structure du réseau de télécommunications ou 
difficultés d'ordre technique, ou pour des raisons ayant trait à la mise à jour des informations 
contenues sur le site ou à la maintenance. 
 
Converteam ne garantit par ailleurs en aucune manière un accès ininterrompu à ce site  ainsi que la 
sécurité du site et l’absence de tout virus ou autres éléments indésirables (y compris dans les 
éléments du site et dans les informations qui y sont incorporées) ou que l’information publiée sur le 
site sera à tout instant exhaustive, exacte et à jour.  
 
- Contenu : 
Converteam s’efforce de présenter sur son site des informations exactes relatives à ses produits.  
 
Toute information fournie sur ce site est fournie "en l'état" , sans garantie d’aucune sorte, expresse ou 
implicite, qu’il s’agisse et sans que cela soit limitatif, de garantie de qualité loyale et marchande, 
d’adéquation à un besoin spécifique ou de non contrefaçon de droits de tiers.  
 
En outre, Converteam exerce son activité au niveau international. Par conséquent, le site peut 
permettre l'accès à des informations ou faire référence à des produits, des procédés, des programmes 
et des services Converteam qui ne sont pas disponibles dans le pays de l'Utilisateur. Ceci ne signifie 
pas que Converteam envisage d'offrir de tels produits, procédés, programmes et services dans un tel 
pays. 
 
- Informations échangées :  



 

 

Converteam ne saurait garantir à l'Utilisateur le secret de la correspondance des courriers 
électroniques ou de tout autre communication utilisant le support du réseau Internet et pouvant être 
captés par un tiers, du fait du mode de circulation des données sur le réseau.  
Il appartient à chaque utilisateur de prendre toutes les mesures appropriées de façon à protéger ses 
propres données et/ou logiciels de la contamination d'éventuels virus circulant sur Internet.  
 
En outre, Converteam ne saurait être considéré comme responsable des conséquences directes ou 
indirectes susceptibles de découler des erreurs de saisie qui pourraient être commises par l'Utilisateur 
ou de toute information inexacte ou incomplète transmises par ses soins via le site.  
 

 
ARTICLE 7. LOI APPLICABLE 

 
Conformément à l’article 17 de la Loi pour la Confiance dans l’Economie Numérique (Loi n°2004-575 
du 21 juin 2004), le droit français est applicable au présent site web. 
 
Tout différend ou litige lié à l’utilisation du présent site web sera exclusivement réglé par les tribunaux 
français compétents. 
 
L'application des règles de conflits de lois, qui restreindrait la pleine application de la loi française, est, 
par la présente, exclue. En conséquence, la loi française s'applique à toutes les personnes qui 
naviguent par le présent site et qui utilisent toute ou partie de ses fonctionnalités 
 
 
******************** 
© - Converteam – 2008. 
 
 
 
 


